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Introduction 

Overview 

With FTR Log Notes you can review timestamped notes that link to exact locations in recordings created by 
TheRecord Empowered programs such as FTR Reporter or FTR Monitor.  Using the companion ThinkLink enabled 

program – FTR Player – you can quickly and efficiently review your recordings and annotations.  

When a program is TheRecord Empowered, it creates recordings that utilize a patented FTR file name 

technology.  This file naming technology is then used by ThinkLink enabled programs to maintain an association 

between the recording and other data that links to the recording.  

Using the ThinkLink technology that is part of FTR Log Notes and FTR Player, you can quickly find specific events 

in a recording - making the review process very efficient. 

You can also use FTR Log Notes and FTR Player to create your own log notes.  

FTR Manager is installed with FTR Log Notes.  With FTR Manager you can: 

• Save an encrypted package of recordings and log sheets for distribution to other parties.  

• Save a copy of recordings in a number of different formats. 

About This Guide 

This User’s Guide assumes that you are familiar with Microsoft Windows operating systems.  If you are new to 

Windows, make use of the extensive Windows help system before attempting to use FTR Log Notes. 
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Getting Started 

Installation 

FTR Log Notes is installed as a component of FTR Annotation Suite.  Refer to the Setup Guide that accompanies 
this product.  When installation is complete, be sure to set General Options. See Configuring FTR Log Notes later 

in this guide. 

Note:  Log in as a member of the local Administrators group if you want to change Administration settings. For 

details on how to configure the program see Configuring FTR Log Notes later in this guide. 

Licensing 

FTR Log Notes requires one of the following license types: 

• Trial evaluation for 14 days. 

• Machine license – permits the use of Annotation Suite on this machine only. 

• Site license – permits the use of Annotation Suite on all machines on this site. 

Either a machine or a site license may have been activated during setup and no further licensing action is 

required. If a 14-day trial evaluation license was chosen, to continue to use FTR Annotation Suite beyond the end 

of the trial period, you must activate either a machine license or a site license. 

License your copy of Annotation Suite by displaying the About dialog and pressing Activate. 
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Activate License 

Use the License Activation page to select your appropriate license. 

 

Choose the first option to license this machine only: 
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On completing Step 1, you will receive a registration file. Email it to licensing@fortherecord.com in order to 

receive your license key. 

 

Use the license key to complete Step 2. 
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Choose the second option if you have a site license: 
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When your license has been successfully activated: 

 

 

  



 

Page 7 

FTR Log Notes™ 

© FTR Pty Ltd, 2020.  All rights reserved. 

For more information visit www.fortherecord.com 

 

Starting 

You can start FTR Log Notes from the desktop, or depending on your operating system, from the Start menu or 

Apps screen.  

To start FTR Log Notes: 

1. From the desktop, double-click the FTR Log Notes icon    or click Start, point to All Programs, then 

ForTheRecord and click FTR Log Notes 

2. Observe that the program starts.  

 

About FTR Log Notes 

The About box lists information about your installation. 

To display the About box: 

1. Do one of the following: 

a. Double-click the FTR Gold logo at the top left corner of the main window or  

b. Click the Menu button  , point to Help and click About FTR Log Notes. 

2. View the information in the About FTR Log Notes dialog box. 

3. Click OK to close the About box. 
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Help 

The following help resources are available: 

• FTR Gold Annotation Suite Setup Guide 

• FTR Log Notes User Guide (this Guide) 

Viewing the Setup Guide 

The Setup Guide is published in Portable Document Format (PDF) and will be available with the purchase of FTR 

Gold Annotation Suite. 

Note:  The Setup Guide requires Adobe® Reader®.   

Viewing the User Guide 

The User Guide PDF is displayed when you click on . 

System Information 

System information is saved in a collection of text files that are stored in a zip file on your desktop and copied to 

your clipboard.  When system information is saved you can view the text files using the text viewer of your choice 

and you can send them to customer support as required. 

To save system information: 

1. Click the Menu button  , point to Help and click About FTR Log Notes. 

2. From the About FTR Log Notes dialog box, click the System Info… button. 

3. Observe a progress dialog box as system information is being saved. 

4. When complete, a message box confirms that saving was successful, and that system information is available 

from the desktop. 

To view system information: 

1. Save system information as described above. 

2. From your desktop, double-click the FTR System Information... zip folder. 

3. From Explorer double-click the text file you wish to view. 

To send System Information: 

1. Save system information as described above. 

2. From your desktop, right-click the FTR System Information... zip folder, point to Send To and click Mail 

Recipient.  Enter the email address for your support team and send the attached system information files. 
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Programmers Reference 

When FTR Log Notes is installed there is an option to include Visual Basic for Applications.  If this option is 

selected the VBA Editor and Programmers Reference are available to customize the way FTR Log Notes works. 

To start the VBA Editor: 

1. Click Start, point to All Programs, ForTheRecord then SDK. 

2. Click Visual Basic Editor. 

3. Use the VBA Help and the Programmers Reference to customize FTR Log Notes. 

To view the Programmers Reference: 

1. Click Start, point to All Programs, FTR Gold then SDK. 

2. Click Programmers Reference. 
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Working Environment 

This section of the guide describes the main components of the FTR Log Notes window.  

FTR Log Notes can be displayed in Normal view or Compact view.  See Configuring FTR Log Notes – Sizing and 
Positioning later in this guide. 

 

Normal View 

 

 

 

 

 

Compact View 

 

 

 

Normal View Button 

Tool bar Menu Button Compact Player - docked 

Log Sheet Pane 

Compact View Button 



 

Page 11 

FTR Log Notes™ 

© FTR Pty Ltd, 2020.  All rights reserved. 

For more information visit www.fortherecord.com 

 

Menu 

To open the menu, click the Menu button  or press Alt. 

 

This section of the user's guide describes each menu. 

File Menu 

The File menu contains the following commands:  

Function Description 

New… Creates a new log sheet that is based on template.  

Open… Opens an existing log sheet.  

Search… Opens the Search dialog box.  Use this dialog box to enter search criteria so that you can quickly find the 
required log sheet.  

Close Closes the active log sheet.  

Save Copy As Saves a copy of the active log sheet to another location.  

Page Setup… Opens the page setup dialog box where you can specify the layout for printed log sheets.  

Print Preview Shows how the active log sheet will be printed.  

Print… Opens the Print dialog box where you can choose how much is printed.  

Properties Displays the file name and path of the active log sheet. 

Most recent list Shows the nine most recently opened log sheets.  You can select any one of these to open.  

Exit Quits the program.  

Edit Menu 

The Edit menu contains the following commands: 

Function Description 

Undo Undo last changes.  

Redo Redo last changes that you have recently undone.  

Edit Mode Switches the log sheet between read-only and editable.  

Format… Opens the format dialog box where you can specify bold, italics, underline and color options.  

Cut Cuts the selected text from the log sheet and places it on the clipboard.  

Copy Copies the selected text from the log sheet and places it on the clipboard.  

Paste Pastes the contents of the clipboard to the insertion point indicated by the cursor position in the log sheet.  

Delete Note Deletes the current log note 

Find… Opens the Find Text dialog box where you specify what text you want to find in the active log sheet.  

Find Next Repeats the find action using the previous find text.  

Synchronize Note Sets the timestamp of the active log note to match the time of the associated content currently open in the 
player.  

Synchronize Sheet Sets the timestamp of the active log note to match the time of the associated content currently open in the 
player and then adjusts all other timestamps by the same amount.  
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View Menu 

The View menu contains the following commands: 

Function Description 

Compact View Changes the FTR Log Notes window to a compact view that shows only four rows of notes. 

Always On Top If selected ensures that the FTR Log Notes window is always on top of other programs. 

Actions Menu 

The Actions menu contains the following items: 

Function Description 

Link Click to set the play time in player to match the timestamp of the current log note. 
Note:  This action is usually performed by clicking the timestamp.  

Set Range Start Sets the range start time in the player to match the timestamp of the current log note.  

Set Range End Sets the range end time in the player to match the timestamp of the current log note.  

Tools Menu 

The Tools menu contains the following items: 

Function Description 

Spelling Starts the spell checker.  See Spell Checking later in this guide.  

Quick Notes Opens the Quick Notes window.  See Quick Notes later in this guide 

Word List Shows or hides the word list window.  See Using The Word List later in this guide.  

Templates Opens the Templates dialog box where you can add, edit or delete templates.  See Managing Templates later 
in this guide.  

Tag Hearing Start Inserts a tagged note that identifies when a hearing starts.   

Tag Hearing Stop Inserts a tagged note that identified when a hearing stops.    

Merge Provides a way to merge multiple log sheets into one while maintaining the originals. 

Filter Provides a way to extract specific notes from a log sheet to create a new log sheet. 

Options Opens a cascading menu of options that control how the program behaves.  See Configuring FTR Log Notes 
later in this guide.  

Window Menu 

The Window menu shows a list of open log sheets from which you can select one to become the active log sheet.  

If more than nine log sheets are open then the More command is available.  Click More to view the complete list 

of open log sheets. 

To activate a different log sheet: 

1. Click the Menu button   and point to Window. 

2. Do one of the following: 

a. Click the log sheet you want to activate or 

b. If available, click More, then from the Activate dialog box click the required log sheet and click OK. 
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Help Menu 

The Help menu contains the following items: 

Function Description 

FTR Log Notes Help Opens the main help. 

About FTR Log Notes Opens the About dialog box, which shows version information and trademark attributions. 

Activate Opens the Activation dialog box. 

Toolbar 

The toolbar contains buttons providing quick mouse access to the main FTR Log Notes functions. 

 

The following table describes each of the FTR Log Notes toolbar buttons. 

Icon Function Action 

 
Menu Click to open the main menu. 

 
New Creates a new log sheet. 

 
Most Recent Click to open the Most Recent log sheet list.  You can select any one of these to open. 

 
Search Locate a log sheet based on defined search criteria 

 
Save Copy As 

Opens the Save Copy As dialog box, which is used to save a copy of the log sheet to another 
location. 

 
Print Click this button to print. 

 
Print Preview Preview the active log sheet before printing 

 
Edit/Read-only Toggles between edit mode and read-only mode.  Click to enable or disable log note editing. 

 
Find Text Opens the Find Text dialog box, which is used to locate specific words in the log sheet. 

 
Spell Check Start the spell checker. 

 
Quick Notes Open the Quick Notes Window 

 
Word List Open the Word List Window 

 
Compact View Changes the FTR Log Notes window to a compact view that only shows 4 rows of notes 
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Log Sheet Pane 

Log sheets are used to annotate events that occur in the recording venue and are displayed in the log sheet 

pane.   

Log Sheet 

A log sheet includes the following components. 

• Log Sheet Tab 

• Log Sheet Heading 

• Log Notes 

• Range Bar 

 
Log Sheet Tab 

Range Bar 

Log Sheet Heading 

Log Notes 
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Log Sheet Tab 

 

Each log sheet opens in a tabbed page and the label displays one of the following titles: 

• First line of the description field or 

• If the Description field is empty then show the Location field or 

• If the Description and Location fields are empty then show the Date. 

One or more of the following status icons may also accompany the title. 

Icon Description 

 The log sheet is associated with the content currently open in player. 

 The log sheet is associated with the recorder 

 The log sheet is read-only and cannot be edited 

Log Sheet Heading 

The log sheet heading contains three fields that identify the log sheet.  These are the Description, Date and 

Location fields. 

 

The Description Field 

The Description field contains text entered by the user and is commonly used to identify the proceeding.  

This might include a case name, case number, presiding officer and appearances. 

When the Description field is not selected only the first line of text is displayed.  To expand the field, select 

it or click  to the right of the field.  The field expands to a maximum of ten lines and displays a scroll bar to 

reveal any additional lines that may be hidden.    To close the field, press ENTER or click anywhere outside 

the field. 

 

The Date Field 

The Date field contains the date of the proceedings. 
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The Location Field 

The Location field identifies the venue in which the proceedings occur.  When creating a log sheet you can: 

• Enter any name. 

• Choose a recently used name 

 

• Use the location name from the content that is open in player.  In this situation the 

location name appears between angled brackets as illustrated above. 

Log Notes 

Log Notes are primarily used to describe events that occur during proceedings.  They are organized and 
referenced by a Time column, a Speaker column and a Note column.  Each row represents one time stamped 

log note. 

Note:  Because the Speaker and Note column titles can be changed, you may have different column titles.  

Changing column titles is generally done at installation time by a user with local administration rights.  See FTR 

Log Notes Options later in this guide. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

The table below describes each component of the Notes section. 

Item Description 

Time Field As each log note is created, a time stamp is automatically entered into the time field.  The time field cannot be 
directly edited.  You may adjust timestamps using the synchronize commands. 

Speaker Field Used to identify who is speaking or the type of event that is occurring.   

Note Field Used to add supplementary information to assist those reviewing the matter.  

Row Selector Click this area to select the whole row (and other rows) for printing and saving a copy. 

Scroll Bar The scroll bar is used to navigate the log sheet if it is larger than the current window. 

Note field 

Time 

field 
Speaker 

field 

Row Selector Scroll Bar 

Log note 

Note Column Speaker Column Time 

Column 
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Range Bar 

The Range bar provides a visual indication that the log sheet is linked to the content currently loaded in the 
player.  The Range Bar is the vertical strip to the left of the log sheet and it shows similar information to that 

displayed on the range bar in the player. 

If the content in the player is linked to the active log sheet then the Range bar shows a blue line that represents 
all loaded content.  A wider shaded area on the line represents the currently selected range in the player and is 

delineated by Range Start and End markers.  The Current Log Note Marker indicates the most recent log note 
that is relevant to the currently playing content in the player.  When the current play time reaches a timestamp in 

the log sheet, the Current Log Note Marker jumps down to the relevant log note. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Current Log Note Marker 

This indicates the most recent log note relevant to the current play time of the linked content.  As the 

content in the player continues to play, the current log note marker moves to show the 

corresponding log note. 

Range Start Marker 

This marker represents the range start time as defined in the Player.  Ranges can be set in player or 

directly from the log note shortcut menu.  See Setting the Audio Range later in this guide for more 

information. 

Content Start 

The top of the thin blue line indicates the start of the linked content. 

Content End 

The bottom of the thin blue line indicates the end of the linked content. 

Range End Marker 

This marker represents the Range end time. 
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Quick Notes and Word List 

While working with a log sheet you can open separate display windows that show the Word List and available 

Quick Notes. 

See Quick Notes and Word List later in this guide for details. 

To open the Quick Notes window, click the Quick Notes button . 

 

To open the Word List window, click the Word List button . 
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Configuring FTR Log Notes 

You can change the size and position of the FTR Log Notes window and you can hide one of the log sheet 

columns as required.  You can also change a number of configuration options to suit the way you work. 

Note:  Log in as a member of the local Administrators group if you want to change Administration settings. 

Sizing and Positioning 

When it is in Normal view, and not maximized, the FTR Log Notes window is re-sizable and can be repositioned. 

FTR Log Notes can also be viewed in Normal or Compact View. 

To switch between Normal and Compact views: 

1. From Normal view, click the Compact View button . 

2. From Compact View, click the Normal View button  

Sizing and Hiding Columns 

You can hide or reveal either the Note or Speaker column as required. 

 

 

 

To change width or hide a column: 

1. In the column title, move the pointer over the border between the Speaker and Note column. 

2. When it changes to a sizing pointer, do one of the following: 

a. Drag the column border to set the required width of the columns. 

b. To hide the column, continue to drag the column border until it collapses to become hidden. 

3. Unhide the column by dragging the border between the hidden column and the visible column.  Keep 

dragging until the column re-appears and set to the required width. 

Note:   

When you resize a column, a message is displayed asking if you want the new width to be applied to all log 

sheets. 

If you answer Yes then all log sheets are displayed with the new width and the size is remembered the next time 

you start FTR Log Notes. 

If you answer No then only the active log sheet is affected and the size is not remembered the next time you start 

FTR Log Notes. 

If there is text in a hidden column then the column title appears red. 
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Changing FTR Log Notes Options 

You can also change a number of configuration options to suit the way you work.  Some options are available to 

all users while others are restricted to local Administrators or Power Users. 

Options are available in the following categories: 

• General – all users 

• Administration - Administrators. 

To change options: 

1. Click the Menu button  , point to Tools and click Options. 

2. Make changes to the following options pages as required: 

General Options 

Administration Options 

3. When all changes are complete, click OK.  

General Options 

 

 

• Timestamp offset.  The Timestamp offset value specifies how much the time stamp of each new log 

note is automatically adjusted to an earlier time.  The offset value is between 0 and 10 seconds. 
The offset value compensates for the delay that occurs between the actual event and when it is noted.  

There is always a delay because it takes time to recognize the need for a note and actually entering the note.  
Different users can set the offset value to suit the way they work.  

• Language.  Select the language you wish to use for spell checking. 

• Accessibility.  Select this option to enhance accessibility. 

• Skin. Switch between the Classic and Default user interfaces. Note that the functionality is identical. 
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Administration Options 

These options are available if you have logged on as a member of the local Administrators group. 

 

 

• New log sheet save location – The option available for this version of FTR annotation Suite is: 

> Folder - All new log sheets will be saved to the specified folder.  Choose this option if you wish to save 

your log sheets directly to a shared network folder.  

• Template location - Templates store Quick Notes which are specific to a particular case type or jurisdiction.  
They are typically stored on a shared network folder. 

• Column titles - The default column titles are Speaker and Note.  If these are not applicable in your 
organization, enter new titles. 
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Templates 

Templates ensure consistency in the use of terminology.  A template is typically created for each case type and is 

stored in a shared network folder for all users to access, as required.  See Administration above. 

Each template includes a set of quick notes that are usually specific to the case type. 

Template Quick Notes 

Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 

shortcut.  Each template includes quick notes, which are copied to the log sheet that is based on the template. 

Note:  When quick notes are edited in a log sheet, they are not changed in the template.  The template ensures 

that a consistent set of quick notes is available when a new log sheet is created.  See Log Sheet Quick Notes in the 

Taking Notes section, later in this guide. 

Managing Templates 

You can create templates containing unique Quick Notes for each case type.  This should be done as part of the 

installation process. 

To manage templates: 

1. Click the Menu button , point to Tools and click Templates. 

2. Observe that the Templates dialog box is open. 

 

3. To create a new template, click New.  Enter a template name and click OK. 
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4. To create a new template based on an existing template, select an existing template and click Copy As.  Enter 

a new name for the template and click OK. 

5. To rename a template, select it from the list of templates and click Rename.  Change the name as required 

and click OK. 

6. To delete a template, select it from the list and click Delete.  To proceed with the deletion click Yes in the 

confirmation dialog box. 

7. When finished you can modify the default quick notes for each template. 

Modifying Template Quick Notes 

Once templates are created, you can define the relevant quick notes.  

To modify template quick notes: 

1. Click the Menu button , point to Tools and click Templates. 

2. From the Templates dialog box, select the template you want to modify and click Quick Notes. 

 

3. Observe that the Quick Notes dialog box opens. 
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4. To add a new quick note do the following:  

a. From the Quick notes dialog box, click New. 

b. In the New key field, enter the required keyboard shortcut. 

c. In the Label field enter the title for the quick note – e.g. Prosecutor. 

Note:  The label field is optional but will be automatically set to the quick note text if you leave it blank. 

d. In the Quick note field, enter the required word or phrase.  You can include control codes to manage the 

placement of text in the log sheet.  For more details, see Control Codes at the end of this section. 

 

e. Click Save to add the quick note to the template. 

f. Repeat this process until all quick notes are added then click Close. 

5. To change an existing quick note do the following:  

a. From the Quick Notes window, select the quick note you want to modify and click Edit. 

b. From the Edit Quick Note dialog box, make the required changes and click OK. 

6. When all quick note changes are complete, click Close to return to the Templates dialog box. 

7. From the Templates dialog box, click Close. 
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Control Codes 

Each quick note can include one or more control codes that control the placement of text in a log sheet.  

Available control codes are:  

<Left>  Moves the cursor to the last position in the Speaker column of the current log note. 

<Right>  Moves the cursor to the last position in the Note column of the current log note. 

<End>  Moves the cursor to the Speaker column of the last empty log note. 

New Line Inserts a new line in the current log note field. 

Note:  Your column titles may be different.  Speaker and Note are default column titles that may have been 

changed. 

You can combine control codes to extend their usefulness.  The table below lists some examples. 

Note: A New Line code is not shown.  Clicking the New Line control code button simply inserts a new line. 

Control Code & Text Result 

<END>Called & sworn<RIGHT> The text, Called & sworn, is immediately inserted in the 

last empty row of the Speaker column, a time stamp is 
automatically generated and the cursor is positioned in the 

adjacent Note column 

<END><RIGHT>Court adjourned A time stamp is automatically generated and the text, Court 
adjourned, is immediately inserted in the Note column of 

the last empty row. 

<LEFT>Exhibit 

Police Record of Interview 

 

 

From the current cursor position moves to the speaker field 

of the current log note and inserts Exhibit.  Then creates a 

new line and inserts Police Record of Interview. 
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 Reviewing 

Using FTR Log Notes, you can review a recording and any associated log sheets.  You can back-annotate a 

current recording or simply review any previous recording. 

With FTR Log Notes you can: 

• Open an existing log sheet 

• Associate a log sheet 

• Find specific text in a log sheet 

• Set a range 

• Synchronize notes 

Opening Log Sheets 

There are three ways to open a log sheet. 

• Open most recent 

• Open 

• Search 
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Open Most Recent 

You can open a log sheet from your list of most recently used log sheets. 

To open a recently used log sheet: 

1. Do one of the following: 

a. Click the Most Recent button , select the required log sheet in the Most Recent dialog box and click 

Open, or 

  

b. Click the Menu button , point to File and click the required log sheet from the File menu. 

Open 

Using Open requires an understanding of where log sheets are stored.  If you don't know where to find your log 

sheets it is simpler to use Search.  See the next section for more details.  

To open a log sheet: 

1. Click the Menu button  , point to File and click Open. 

2. From the Open dialog box, navigate to the required drive, folder and log sheet.  

 

3. Click Open. 
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Search 

Searching provides a more efficient way of finding and opening log sheets.  You can specify a number of different 

criteria to search for the required log sheet. 

From the Results list, you can copy, delete or print log sheets without the need to open them.  Finally, one or 

more (maximum of 10) log sheets can be opened for review. 

The diagram below illustrates the Search dialog box.  The table following this diagram describes each element. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Element Description 

Description Use the Description box to enter text you know can be found in the Description field of the required log sheets. 
This is the most frequently used search parameter. 

Location If you know where the case was heard, use this box to enter a Location name.  

Log Notes Use this box to enter text you know can be found in the Speaker or Note fields of the required log sheets. 

Search period Always use a search period to limit the scope of the search. 

Search Click this button to search with the defined criteria. 

Reset When you click this button, all text boxes are cleared and the search period is set to one month from the current day. 

Look in This is a list of search folders which are setup at installation time by your administrator or support staff 

Results When a search concludes all log sheets that match the search criteria appear in this list.  To view more information about 
each log sheet point to the Description to open a screen tip that shows the full description. 

Open Opens one or more log sheets from the results list. 

Save Copy As Saves a copy of one or more logs sheets to another location. 

Print Click this button to print one or more log sheets from the results list. 

Delete Deletes one or more log sheets.  Deleted log sheets are moved to the recycle bin and can be restored. 

Close Closes the Search dialog box.  You can keep the dialog box open while you work with FTR Reporter. 

Search Now 

Close 

Delete Print Save Copy As 

Open 

Search 

Results 

Look in  

search folder 

Search text 

Search period 

Reset  

search criteria 

Manage  

Search Folders 
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To search for log sheets: 

1. Do one of the following:  

a. Click the Search button  or 

b. Click the Menu button  ,point to File and click Search 

2. In the Search dialog box, enter search criteria as previously described. 

3. Do one of the following: 

a. Accept the folder currently displayed in the Look in box or 

b. Change the Look in Search Folder by selecting from the list. 

Note:  If you have administration permissions you can click Manage and modify the list of available 

search folders. 

c. Click the Look in box and select folder from the list of previously used folders. 

Note:  The specified Look in folder, and all sub-folders will be searched. 

4. Click Search Now.  Log sheets that match your search criteria are displayed in the search results list. 

Note:  You can change the sort order of the Search Results list by clicking on the Date, Location or 

Description headings.  

5. Select one or more log sheets and click Open. 
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Save Copy As, Print or Delete Multiple Log Sheets 

Once you have completed a search, all log sheets matching the search criteria appear in the Search Results list.  

You can open, save a copy, print or delete one or more of the listed log sheets.  

To select a single log sheet, simply click the log sheet in the Search Results list.  To select multiple log sheets, 

hold the SHIFT key down while clicking the first and last log sheets in a series of adjacent log sheets.  To select 

multiple log sheets that are not adjacent, hold the CTRL key down while clicking each required log sheet. 

Note:  You can delete or save copy of, up to 100 log sheets.  You can open or print a maximum of ten log sheets. 

To open log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets, to a maximum of 10, from the Search Results list. 

3. Click Open. 

Note:  Log sheets open in read-only mode 

To copy log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets (to a maximum of 10) from the Search Results list. 

3. From the Search dialog box click Save Copy As. 

4. From the Save Copy As dialog box choose a file name and file type. 

Note:  You can only change the name if a single log sheet is selected. 

 

5. Click Save. 
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To print log sheets from the Search window: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets (maximum of 10) from Search Results and click Print. 

3. From the Print dialog box do one or both of the following: 

a. Select the Heading Pages check box to print the contents of the Description, Date and Location 

fields. 

b. Select the Log notes option to print all notes. 

Note:  The Selection option is not available when printing from the Search dialog box.  See Printing 

later in this guide for details on printing a selection from the active log sheet. 

 

4. Click OK. 

5. The selected log sheets are printed using the default printer and page setup.  For details on changing the 

default page setup see Printing later in this guide. 

To delete log sheets: 

1. Perform a search for the required log sheets - as previously described. 

2. Select one or more log sheets from the Search Results list. 

3. Click Delete. 

4. A dialog box prompts you to confirm the deletion.  Click Yes to proceed.  All selected log sheets are deleted 

from the current directory but are available for restoration from the system Recycle Bin. 
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Associating a Log Sheet 

When you open an existing log sheet, it may not be associated with the recorder or the content that is open in 

the player.  To enter log notes in such a log sheet it must be associated with content that is open in the player. 

Associating a log sheet with a recording makes the timestamps available for locating specific events in the audio.  
It also adds the Range Bar to the log sheet, which indicates any Range Start times, Range End times and the 

most recent log note relevant to the current playtime. 

An associated log sheet provides updates on the relationship between the notes and the Current Play Time in 
the player.  As the Current Play Time advances the Current Log Note Marker automatically jumps to the 

next relevant log note as the log note time is reached.  If the log note is hidden when this occurs the log sheet is 

automatically scrolled to make it visible. 

To associate a log sheet: 

1. Open the required log sheet.  See Opening Log Sheets earlier in this guide. 

2. Do one of the following: 

a. Click a time stamp or 

b. Position the cursor in a log note, click the Menu button , point to Actions and click Link. 

3. Observe the following: 

If not already started, the player starts and then scans search folders for any recordings that include the date 

and location of the log sheet.  If recording content is found with matching location name and date then it is 

loaded and the current play time set to the log sheet timestamp. 

Note:  Search folders are scanned in the order they are defined in the player properties.  The first matching 

recording is opened.  See FTR Player help or user’s guide for details. 

4. If matching audio is not found a message is displayed. 

Take the necessary steps to find and open the required audio.  See the FTR Player User’s Guide or help.  If the 

log sheet contains a Location Name that does match any recording in any folder then it may be incorrect.  

Check that the Location Name is correct.  If you know that a recording does exist then use the player to find 

and open it.  Then, from the log sheet, click the Location field and select the entry that matches the date and 

location of the recording.  Respond accordingly to any message box that is displayed. 

5. The associated audio opens in the player.  The Range Bar is displayed to the left of the log sheet and the 

current play time is set to the same time as the selected log note. 
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Setting the Audio Range 

If you are only interested in a certain group of events in the log sheet then you can limit the range of content 

available for review by setting a Range Start and Range End from the log sheet.  

A range can only be set from the log sheet if it is associated with the content that is open in the player.  Alternatively, 

you can set a range directly in the player – see the FTR Player User's Guide or help for details. 

To set an audio range from the log sheet: 

1. Locate the log note that marks the beginning of the required range. 

2. Right-click the log note and click Set Range Start from the shortcut menu. 

3. Locate the log note that marks the end of the required range. 

4. Right-click the log note and click Set Range End from the shortcut menu. 

Note:  When a Range Start or Range End time is set a visual indication is provided in the Range Bar to 

the left of the log sheet.  See Range Bar earlier in this guide. 

Synchronizing Notes 

If a log sheet is created on a different computer from the one that created the audio recording it is possible that 
a discrepancy exists between the log note time stamps and the associated audio times for the related events.  If 

this situation exists then you can easily synchronize all timestamps in the log sheet, to the correct audio times, in 

a single step.  

It is also possible that a single log note is added too late to match the event in the audio.  Such an incorrectly 

time stamped log note can be synchronized to the actual event in the recording.  

Synchronizing a Log Sheet 

Synchronize Sheet is available from the Edit menu when a log sheet is in edit mode and the content loaded in 

the player, matches the location name and date of the log sheet. 

To synchronize all notes in a log sheet: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach a distinct event that is described by a specific log note and then stop. 

4. Click the Menu button , point to Edit and click Synchronize Sheet. 

5. A dialog box prompts you to confirm the synchronization.  Click Yes to proceed. 

6. Observe that all log note time stamps are adjusted by the same amount. 
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Synchronizing a Log Note 

Synchronize Note is available from the shortcut menu or the Edit menu when a log sheet is in edit mode and 

the content loaded in the player, matches the location name and date of the log sheet.  

To synchronize an individual log note with a recording: 

1. Open the log sheet and switch it to edit mode. 

2. Associate the log sheet as previously described. 

3. Play until you reach the distinct event for which the log note time stamp requires adjustment. 

4. Position the cursor in the log note you wish to adjust. 

5. Do one of the following: 

a. Click the Menu button  , point to Edit and click Synchronize Note or  

b. Right-click the log note and click Synchronize Note from the shortcut menu. 

6. The time stamp for the selected log note is adjusted. 

Filtering Notes 

The Filter tool provides a way of extracting specific log notes from a log sheet.  For example if you wish to make 

up a witness list you could filter the log sheet based on the phrase Witness called.  When the filter is activated a 
new log sheet opens consisting of all the notes that contain the selected phrase.  The heading information is the 

same as the original log sheet. 

When the temporary filtered log sheet is created it is locked to editing and is not saved.  If you close the filtered 

log sheet it is permanently deleted.  If you want to save or edit the filtered log sheet then save a copy, close the 

original (which is deleted on closing) and then open the copy.  The copy can be switched to edit mode. 

To filter notes: 

1. Do one of the following: 

a. Select the word or phrase to use as the filter text or 

b. Position the cursor in the required field - this action automatically uses the entire field contents as the 

filter text. 

2. Click the Menu button , point to Tools and click Filter. 

3. A message box reminds you to save a copy if you want to keep the log sheet.  Click OK to continue. 

4. The log sheet is scanned and any notes (rows) that contain the required filter text (in the same column as the 

required filtered text) are extracted and placed in a new active log sheet, which is locked to editing. 

5. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As or click the 

Save Copy As  button from the toolbar. 
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Merging Log Sheets 

With FTR Log Notes, you can merge multiple log sheets to create a new log sheet.  The heading and column 
titles of the active log sheet are used to create the heading and column titles of the newly merged log 

sheet.  The Description field is modified with a new first line containing the word Merged. 

When the temporary merged log sheet is created it is locked to editing and is not saved.  If you close the merged 

log sheet it is permanently deleted.  If you want to save or edit the merged log sheet then save a copy, close the 

original (which is deleted on closing) and then open the copy.  The copy can be switched to edit mode. 

To merge log sheets 

1. Open the log sheets to be merged. 

2. Select the log sheet containing heading information that you want copied to the heading of the merged log 

sheet. 

3. Click the Menu button , point to Tools and click Merge. 

Note: If one or more log sheets have different dates then a warning is generated.  You can still proceed with 

the merge but be cautious with log sheets of differing dates. 

4. From the Merge dialog box click Yes to merge the open log sheets.  The merged log sheet is displayed as the 

active log sheet and is locked to editing. 

5. Observe that the merged log sheet is the active log sheet and it is locked to editing. 

6. If you wish to keep the log sheet, click the Menu button , point to File and click Save Copy As or click the 

Save Copy As button  from the toolbar. 

Finding Text 

While reviewing a log sheet, it may be necessary to quickly locate notes pertaining to a particular event, speaker 
or comment. Use Find as a fast and effective method for searching the active log sheet for any occurrences of a 

specific word or phrase in the current log sheet.  

To find a word in a log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to Edit and click Find or  

b. Click the Find button . 

2. In the Find Text dialog box, enter the text you wish to find. 

 

3. Click Find.  The Find Text dialog box is closed and the first occurrence of the required text is highlighted in the 

log sheet. 

4. To locate the next occurrence of the required text press ALT+F3. 
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Editing Log Sheets 

You can edit the contents of an existing log sheet at a later date.  When opening an existing log sheet it is 

displayed in read-only mode.  To make changes to the log sheet, change to edit mode.  

To switch between read-only and edit modes: 

• Click the Edit/Read-only button  or click the Menu button , point to Edit and click Edit Mode. 

Editing Existing Information 

You can edit the contents of an existing log sheet at a later date.  When opening an existing log sheet it is 

displayed in read-only mode.  To make changes to the log sheet, change to edit mode.  

To edit the log sheet: 

1. If not in edit mode, click the Edit/Read-only button  or click the Menu button , point to Edit and click 

Edit Mode. 

2. Enter or modify the Description field, as required. 

3. Select the log note field you wish to edit. 

4. Make changes as required. 

Adding a Log Note 

New notes can only be added to an existing log sheet when the log sheet is associated with the content that is 

currently open in the player. 

To add a log note to a log sheet: 

1. In the player, set the current play time to the time that requires a note. 

2. Press ENTER to position the cursor in the last row.  The last row is an empty log note. 

3. Enter the required log note.  At the first key press the log note is time stamped instantly and moved to the 

correct chronological position in the time sheet. 

Deleting a Log Note 

You can delete a log note if the log sheet is in edit mode.  Multiple notes cannot be deleted.  

To delete a log note: 

1. Right-click in any column of the log note to be deleted. 

2. From the shortcut menu click Delete Log Note. 

3. A dialog box prompts you to confirm the deletion.  Click Yes to proceed. 
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Taking Notes 

FTR Log Notes includes a powerful note-taking feature that links each note to a precise place in a recording.  The 

recording must be created with program or device that is TheRecord Empowered, such as FTR Reporter or 

ReporterDeck 2.  Using this feature you can take brief notes as each event occurs and use them later when 
reviewing the recording.  As you enter each note, an automatic timestamp is added that links the note to the 

relevant place in the recording.  For this to occur the log sheet must be associated with the content that is open 

in FTR Player.  

An association exists when the date and location name of the log sheet matches the date and location name of 

the content that is open in FTR Player. 

Log Sheet Status Icons 

When you create a new log sheet, the log sheet tab includes status icons that indicate the relationship between 

the log sheet and the content that is open in FTR Player. 

 

Icon Description 

 This log sheet is associated with the content currently open in player. 

None The log sheet is not associated with the content open in FTR Player. 

 The log sheet is read-only and cannot be edited 

Creating a Log Sheet 

Normally, a new log sheet is automatically associated with the selected recorder.  A log sheet and recorder are 

associated when the date and location name in the log sheet matches the date and location name of the selected 

recorder. 

However, if the content in the player is not associated with the selected recorder, you are prompted to choose 

which content you want associated with the log sheet.  

There are two ways to create a new log sheet. 

• Create a new log sheet based on a template.  

• Create a new log sheet based on an existing log sheet.  
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Create a Log Sheet Based on a Template 

When new log sheet is created it is normally associated with a compatible recording that is open in FTR Player.  A 
log sheet and recording are associated when the date and location name of the log sheet matches the date and 

location name of the recording.  

You can also create a log sheet that is standalone and not associated with any recording at the time you enter 
notes.  A stand-alone log sheet is typically created by a court participant that does not have access to the 

recording while the court is in session.  Notes can still be taken while listening to live proceedings and then 

associated with the recording later, as required. 

As part of the installation process for FTR Log Notes, your administrator creates templates that define standard 

quick notes for each case type.  You can choose one of these templates when you create a new log sheet.  

When you create a log sheet template quick notes are copied into the log sheet. 

To create a new log sheet from a template: 

1. To create a new log sheet that is associated with an existing recording, open the recording in FTR Player first.  

See FTR Player help for details on opening an existing recording.  Otherwise, go to the next step. 

2. Do one of the following: 

a. Click the  Menu button , point to File and click New or 

b. Click New  from the toolbar. 

3. If more than one template is available, the Choose a Template dialog box is displayed.  Select a template and 

click OK. 

4. Observe the following: 

a. If you created a new log sheet immediately after opening the relevant recording in FTR Player, the 

location and date fields are automatically completed - and are the same as the date and location of the 

open recording. 

b. If you created a stand-alone log sheet, the date field is completed but the location field is empty.  Enter a 

location name - this is typically the jurisdiction and room number.  You can associate it later. 

Continue from an Existing Log Sheet 

Some matters can take several days or weeks to reach a conclusion.  To ensure that information is retained from 

one day to the next, you can create a new log sheet based on an existing log sheet.  The Description, quick notes 

and word list are copied from the old log sheet to the new log sheet. 

You can continue from: 

• A recent log sheet. 
Using this method, you do not have to open an earlier log sheet to continue with a new log sheet. 

• The active log sheet. 

This method requires that you open a log sheet first.  This is necessary if the required log sheet is no longer 
in your list of most recently used log sheets. 
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Continue From a Recent Log Sheet 

When continuing from a recent log sheet it is not necessary to open the log sheet.  

To continue from a recent log sheet: 

1. Click Most Recent . 

2. From the Most Recent dialog box, select the required log sheet and click Continue from. 

3. Observe the following: 

a. A new log sheet is created. 
If you created a new log sheet immediately after opening the relevant recording in FTR Player, the 

location and date fields are automatically completed - and are the same as the date and location of the 

open recording. 
If you created a stand-alone log sheet, the date field is completed but the location field is empty.  Enter 

a location name - this is typically the jurisdiction and room number.  You can associate it later – See 

Associating a Log Sheet earlier in this guide. 

b. The Description field contains all the information from the recent log sheet. 

4. Make any required changes to the information in the Description field. 

5. Make any required changes to the quick notes that were copied from the recent log sheet. 

Continue From the Active Log Sheet 

When continuing from an active log sheet it must first be opened. 

To continue from an old log sheet: 

1. Search for and open the required log sheet.  See File Search later in this guide. 

2. Click the Menu button , point to File and click Continue from. 

3. Observe the following: 

a. A new log sheet is created with the current date and recorder location name.  

If you created a new log sheet immediately after opening the relevant recording in FTR Player, the 
location and date fields are automatically completed - and are the same as the date and location of the 

open recording. 

If you created a stand-alone log sheet, the date field is completed but the location field is empty.  Enter 
a location name - this is typically the jurisdiction and room number.  You can associate it later– See 

Associating a Log Sheet earlier in this guide. 

b. The Description field contains all the information from the recent log sheet. 

4. Make any required changes to the information in the Description field. 

5. Make any required changes to the quick notes that were copied from the recent log sheet. 

6. If necessary, close the older log sheet from which you continued the new log sheet.  
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Entering Heading Information 

The log sheet heading consists of the Description, Date and Location fields. 

 

Description Field 

Use the Description field to describe the contents of the log sheet. 

Whenever a new log sheet is started the cursor is automatically positioned in the empty Speaker field.  While it 

is recommended that you enter a description before a case commences it is not mandatory.  You can enter a 

description at any time. 

To enter text in the Description field 

1. Click the Description field or press CTRL+HOME. 

2. Enter the required text.  As you type, the text wraps to the next line as required. 

Tip:  If you wish to force a new line, press SHIFT + ENTER. 

3. When you have completed the entry for the Description field press ENTER. 

Note:  When you press ENTER, the cursor jumps to the last row of the log sheet.  The last row is always an 

empty note. 

The Location Field 

The Location field may or may not contain information when the log sheet is created, depending on the 

availability of content loaded in the player. 

When a new log sheet is created the Location field is automatically completed if FTR Player is started and 

contains content that was created using a program that is TheRecord Empowered. 

Note:  If a Location Name is automatically supplied, it is recommended that you do not enter your own location 

name. 

If you start FTR Player and load content after you create a new log sheet then open the Location field list and 

choose the entry that appears between angle brackets. 

To enter a location name: 

1. Do one of the following: 

a. If  the required content is already loaded in the player then accept the default name (recommended) or 

b. If you load the required content in the player after creating the log sheet then open the Location field and 

select the name between angled brackets or 

c. If there is no content available in the player then enter you own Location Name. 
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Date Field 

The Date field is automatically completed when the log sheet is created.  The date appearing in this field is one 

of the following: 

• Computer system date if: 

FTR Player is not started. 
FTR Player is started but not loaded with any content.  

• Date of recording if: 
The content that is open in FTR Player was created by a program that is TheRecord Empowered. 

Entering Log Notes 

If you are working with a new log sheet, it will be in edit mode.  If you have opened an existing log sheet, it will 

be in read-only mode (  in the log sheet tab).  The active log sheet must be in edit mode and be associated with 

the content that is open in FTR Player.  

To add a log note: 

1. Create a new log sheet or open an existing log sheet. 

2. If you have access to an associated recording then open it with FTR Player, otherwise skip this step. 

3. If the log sheet is read-only ( ), click the Edit/Read-only button  from the toolbar. 

4. Do one of the following: 

a. Press ENTER from anywhere in the log sheet to move to the last blank log note row or click to select one 

of the last empty fields and start typing when you hear an event that requires a note.  This action 

automatically inserts a time-stamp. 

Note:  The first key press could also be a quick note.  See Quick Notes later in this guide. 

b. Press CTR+ENTER to add an instant timestamp at the end of the log sheet, without entering text.  You 
can go back and add the text when convenient.  Use this method when events are happening faster than 

you can enter notes. 

5. If you want to add notes for earlier times in the recording see Back Annotating in the Review Log Sheets later 

in this guide. 

Deleting a Note 

It sometimes occurs that a log note is created in error or becomes redundant.  You can delete a single log note 

whenever the log sheet is in edit mode.  Multiple notes cannot be deleted in a single operation.  

To delete a log note: 

1. Do one of the following: 

a. Right-click in any column of the log note to be deleted and click Delete Log Note or 

b. Position the cursor in the note to be deleted, click the Menu button , point to Edit and click Delete 

Log Note. 

2. A dialog box prompts you to confirm the deletion.  Click Yes to proceed. 
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Tagging Hearings 

In some work environments it is necessary to produce a single recording file for each hearing created during the 
day.  The single recording file is created using a task in FTR Manager - Export panel.  The Covert Tagged 

Recordings task searches each log sheet for tags that identify the start and end of each hearing and creates the 

recording files.  The tags are inserted as notes using the Tag Hearing Start and Tag Hearing Stop commands.  

The Tag Hearing Start command prompts the user for a suitable name to identify the hearing - typically a case 

reference number or name.  This information is used to name the mp3 recording file that is created. For this 

reason it is important to not edit the note, once it is inserted in the log sheet. 

A typical hearing start tag looks like this: 

<Hearing Start> <123 of 2011> MP3 file name.  DO NOT EDIT THIS NOTE 

To insert a hearing tag: 

1. Do one of the following: 

a. Open an existing log sheet and click a timestamp to open the associated recording or 

b. Open an existing recording in FTR Player and create a new log sheet. 

2. Play the recording and when the hearing starts, do one of the following: 

a. Click the Menu button   , point to Tools and click Tag Hearing Start 

b. or press Alt+H. 

3. In the Tag: Hearing Start dialog box, enter the hearing name. 

4. Observe that a Hearing Start tag is inserted in the log sheet. 

5. Continue with playback and when the hearing ends, do one of the following: 

a. Click the Menu button  , point to Tools and click Tag Hearing Stop or 

b. Press Ctrl+Alt+H 

Note:  Always insert a Tag Hearing Stop note when each hearing concludes, EVEN IF IT IS THE LAST 

HEARING OF THE DAY.  The Tag Hearing Stop note is used by FTR Manager to find the end of each hearing. 

6. Continue with this process until all hearings are tagged. 

Note: ALT+H and Ctrl+Alt+H are the default keyboard shortcuts.  These can be changed in the VBA code if 

required.  Please consult the Administrators guide for details. 
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Selecting Text 

While working with log sheets you can select portions of text in a field to:  

• Apply formatting 

• Add to Quick Notes 

• Delete 

• Copy to the clipboard 

You can also select a number of notes (rows) to: 

• Save as a new log sheet 

• Print 

• Apply formatting (maximum of 10 rows at a time) 

Mouse Selection 

The following steps describe how to select text or rows using the mouse. 

To select text within a log note field: 

1. Position the cursor in the first word of the required text. 

2. Double click to select the current word or drag the cursor over the required text. 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 

1. Position the pointer over the row selector for the first required log note. 

Row Selector →  

2. When the pointer changes to a right arrow, click to select the current row. 

3. To add more rows to the selection do one of the following: 

a. Press SHIFT and click the row selector of the last required log note, in a range of adjacent notes, to select 

all notes between or 

b. Press CTRL and click the row selector of each log note you wish to add to the selection. 

4. Carry out the required action on the selected text. 
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Keyboard Selection 

The following steps describe how to select text or rows using the keyboard.  

To select text within a log note field: 

1. Position the cursor where you want the selection to start. 

2. Do one of the following: 

a. Press SHIFT+RIGHT to select the character to the right and repeat until the required text is selected or 

b. Press SHIFT+LEFT to select the character to the left and repeat until the required text is selected or 

c. Press SHIFT+END to select to the end of the line or 

d. Press SHIFT+HOME to select to the beginning of the line or  

e. Press SHIFT+DOWN to select to the end of the current line plus the all text in the next line - up to the 

same relative cursor position or 

f. Press SHIFT+UP to select to the beginning of the current line plus the all text in the previous line - back to 

the same relative cursor position 

Tip:  To cancel the current selection, press any cursor key.  To replace the current selection, start typing. 

3. Carry out the required action on the selected text. 

To select one or more notes (rows): 

1. Position the cursor in the first row of the required selection. 

2. Do one of the following: 

a. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in the last 

row of the required adjacent block of rows.  Press CTRL+SHIFT+SPACEBAR to select all rows between or 

b. Press CTRL+SPACEBAR to select the current row and then press UP or DOWN until the cursor is in the 
next required row.  Press CTRL+SPACEBAR to add the row to your selection.  Repeat this for all required 

rows or 

c. Use both previous methods to select a combination of adjacent and non-adjacent rows. 

Tip:  Pressing ESC (or any keyboard combination other than those described above) cancels the whole 

selection.  The cursor remains in its current position when the selection is cancelled. 

3. Carry out the required action on the selected text. 



 

Page 45 

FTR Log Notes™ 

© FTR Pty Ltd, 2020.  All rights reserved. 

For more information visit www.fortherecord.com 

 

Formatting Text 

While creating notes, it is often helpful to highlight selected text in some way.  You can do this by applying 

formatting to the required text or row. 

Available formatting options are: 

• Style - Bold, Italics and Underline or any combination 

• Color 

You can apply formatting to selected text or you can simply change the format at the current cursor position and 

any new text that is entered there adopts the newly selected format. 

When opening the Select Format dialog box with text selected, the options indicate the current formatting of 
the selection.  If part of the selection is formatted differently to other parts of the selection, then the relevant 

formatting option is shaded.  Clicking a shaded option clears that format from the entire selection.  Leaving the 

shaded option has no effect on that format option and the selection remains unchanged. 

Note:  If you have multiple rows selected then the format dialog box shows all options cleared. 

To format log note text: 

1. Do one of the following: 

a. If you wish to apply formatting to existing text or notes then make the required selection.  

b. If you wish to apply formatting to text yet to be entered, position the cursor where the new text is to 

start. 

2. Do one of the following: 

a. Click the Menu button , point to Edit and click Format or 

b. Right-click the selection or insertion point and click Format from the shortcut menu. 

3. From the Select Format dialog box, select a Style and Color. 

 

4. When the required format selections are made, click OK. 
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Log Sheet Quick Notes 

Quick notes are commonly used words or phrases that are inserted in a log sheet with a simple keyboard 
shortcut.  When a log sheet is created, quick notes are copied from the template and stored in the log sheet.  

These copied quick notes become the log sheet quick notes.  Any changes made to log sheet quick notes are 

stored in the log sheet and have no effect on template quick notes. 

Note:  When quick notes are edited in a log sheet, they are not changed in the template.  The template simply 

ensures that a consistent set of quick notes is available when a new log sheet is created.  Template quick notes 

can be edited – see Managing Template Quick Notes earlier in this guide. 

Viewing Quick Notes 

You can view the full list of quick notes contained in your log sheet by opening the quick notes window.  While 

the quick notes window is not required to insert quick notes in a log sheet, it is required if you want to make 

changes to your quick notes. 

To view the quick notes contained in your log sheet: 

1. Do one of the following: 

a. Click the Quick Notes button  or 

b. Click the Menu button , point to Tools  and click Quick Notes. 

2. Observe that the Quick Notes window is displayed.  Position and size the window to suit your desktop layout. 

 

3. To view the full quick note, point to the required note and a screen tip is displayed. 

Note:  The Copy button is used for printing quick notes.  See Printing Quick Notes later in this guide for more 

details. 
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Creating a New Quick Note in the Log Sheet 

There are two ways to create a new quick note. 

• Open the Quick Notes window and click the New button or 

• Select text in your log sheet and use a keyboard shortcut to add it to the list of quick notes. 

Creating Quick Note from the Quick Notes Window 

Use this method if you want to view your current quick notes while you make changes. 

To add a new quick note: 

1. Open the Quick Notes window.  See the previous section. 

2. From the Quick Notes window, click New. 

3. Observe that the New Quick Note dialog box opens.

 

4. Do the following: 

a. In the New key field, enter the required keyboard shortcut. 

b. In the Label field enter the title for the quick note – e.g. Prosecutor. 

Note:  The label field is optional but will be automatically set to the quick note text if you leave it blank 

c. In the Quick note field, enter the required word or phrase.  You can include control codes to manage 

the placement of text in the log sheet.  For more details, see Control Codes at the end of this section. 

5. Click Save to add the quick note to the template. 

6. Repeat this process until all new quick notes are added then click Close. 
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Creating a Quick Note from a Selection 

Use this method to create a Quick Note from a selection of text in your log sheet. 

Note:  The Quick Notes window does not need to be open when adding new notes with this method. 

To make a quick note from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new quick note. 

2. Press Shift+F3. 

3. Observe - the New Quick Note dialog box opens with the selected text shown in the Quick Note box. 

 

4. Enter a keyboard shortcut in the New Key box and an optional Label. 

5. Enter any relevant control codes. 

6. Click OK. 
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Editing and Deleting Quick Notes 

You can edit existing quick notes from the Quick Notes window.  See Viewing Quick Notes earlier in this section.  

To edit existing quick notes: 

1. From the Quick Notes window, select the quick note you want to change and click Edit. 

2. Observe that the Edit Quick Note dialog box opens and that the quick note details are available for editing.

 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

To delete a quick note: 

1. From the Quick Notes window, select the quick note you want to delete. 

2. Click Delete.  

3. Click Yes from the confirmation dialog box to proceed with the deletion. 
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Inserting Quick Notes in a Log Sheet 

You can insert a quick note in your log sheet using keyboard shortcuts or from the Quick Notes window.  

Tip:  When inserting a quick note using keyboard shortcuts, the quick notes window does not need to be open. 

To insert a quick note: 

1. If you want to insert a quick note using the assigned keyboard shortcut, do the following: 

a. Position your cursor where you want the quick note inserted in your log sheet. 

b. Press the assigned keyboard shortcut for the quick note. 

Tip:  If you are unsure of the assigned keyboard shortcuts you can open the Quick Notes window and leave 

it open while you work.  See Viewing Quick Notes earlier in this guide. 

2. If you want to select a quick note from a list then do the following: 

a. Open the Quick Notes window.  See Viewing Quick Notes earlier in this guide.

 

b. Position your cursor where you want the quick note inserted in your log sheet. 

c. Do one of the following: 

d. Double-click the required item from the list. 

e. Click the required item from the list and press Enter. 

f. In the Type the item.. box, start typing the label.  As a label matches what you type it is highlighted in 

the list.  When the required item is highlighted, stop typing and press Enter. 

3. Observe that the quick note is inserted in your log sheet. 
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Word List 

The Word List stores information that can be viewed in a separate window from the log notes.  Typical uses for a 

word list are: 

• Spelling list - keeps a record of difficult words or names.  The list becomes a reference for transcription staff. 

• Witness list – keeps a log of witnesses as they appear. 

Viewing the Word List 

• You can view the Word List while you work.  

To view the Word List: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List is now displayed in a separate window. 

 

3. Size and position the Word List window to suit your desktop. 
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Creating a New Word List Item 

There are two ways to add items to the Word List.  

• From the Word List window, click New or 

• Select text in your log sheet and use a keyboard shortcut to add it to the list. 

Creating a Word List Item from the Word List Window 

Use this method if you want to view the list while you make changes. 

To add an item to the list: 

1. Open the Word List window.  See the previous section. 

2. From the Word List window, click New. 

3. From the New Item dialog box, enter the text you wish to add and click Save. 

 

4. Observe that the new item is now displayed in your list. 

Creating a List item from a Selection 

Use this method to create a list item from on a selection of text in your log sheet.  

Note:  The Word List window does not need to be open when adding new items to the list. 

To add a list item from a selection: 

1. From your log sheet, select the word or phrase you want to add as a new list item. 

2. Press Shift+F4. 

3. When the item is added, a confirmation dialog box is displayed.  Click OK. 

Editing and Deleting Word List Items 

You can edit or delete existing items from the Word List.  

To edit the Word List: 

1. From the Word List window, select the item you want to change and click Edit. 

2. Observe that the Edit Item dialog box opens and that the item details are available for editing. 

3. Make the necessary changes and click OK. 

4. Repeat this process until all changes are completed. 

To delete a Word List item:  

1. From the Word List window, select the word list item you want to delete. 

2. Click Delete. 

3. Click Yes from the confirmation dialog box to proceed with the deletion. 
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Inserting Word List Items in a Log Sheet 

You can insert a Word List item in your log sheet from the open list window.  

To insert a Word List item: 

1. Click the Menu button , point to Tools and click Word List. 

2. Observe that the Word List window is open. 

 

3. Position your cursor where you want the list item inserted in your log sheet. 

4. Do one of the following: 

a. Double-click the required item from the list. 

b. Click the require item from the list and press Enter. 

c. In the Type the item box, start typing the item.  As a list item matches what you type, it is highlighted in 

the list.  When the required item is highlighted, stop typing and press Enter. 

5. Observe that the list item is inserted in your log sheet. 
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Spell Checking 

FTR Log Notes includes a spell checker, which can check the spelling of a selection or the whole log sheet.  

To spell check: 

1. To check a selection of text, make your selection first.  See Selecting Text earlier in this guide.  With nothing 

selected, the whole log sheet is checked. 

2. Do one of the following: 

a. Click the Menu button , point to Tools and click Spelling or 

b. Click the Spell Check button  

3. Observe that if a spelling mistake is found in any field of the log sheet, the Check Spelling dialog box is 

displayed. 

 

The log sheet field that contains the error is displayed in the dialog box and the error is highlighted in the 

Not in Dictionary box. 

4. From the Check Spelling dialog, take the necessary steps as required. 

5. When spell checking is finished, a confirmation message is displayed.  Click Yes. 

Note:  You can change the language setting for the spell checker when the Check Spelling dialog box is 

displayed – click Options. 

Alternatively you can set the language in General Options.  See Changing General Options earlier in this guide. 
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Saving and Copying Log Sheets 

FTR Log Notes automatically saves the active editable log sheet at regular time intervals.  Automatic saves also 
occur every time you change the information in one field and then move to another field.  If a problem arises 

with automatic saving, the process for recovery depends on where the log sheet is being saved.  See Recovering 
From a Save Failure later in this section. 

You can also save a copy of the current log sheet, or a selection of notes from the active log sheet, to another 

location.  After saving a copy the original log sheet remains active.  To view the copy, follow the normal 

procedure for opening a log sheet. 

When saving a copy you can choose one of two formats. 

• FTR Log Sheet (*.fls) 

• Web Page (.htm) - for users that do not have access to FTR Log Notes. 

When saving a selection of notes, the Log Sheet Heading is also saved. 

To save a copy of a log sheet: 

1. If required, select the relevant notes. 

2. Click the Menu button , point to File and click Save Copy As  from the toolbar. 

3. Observe that the Save Copy As dialog box is displayed. 

 

4. From the Save Copy As dialog box do the following: 

a. Choose a drive and folder in which to copy the log sheet. 

b. Choose the format from the Save as type list. 

c. Enter the required name in the File name box or accept the default. 

5. When you are satisfied that your file name and type are correct, click Save to save a copy of the log sheet. 
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Recovering From a Save Failure 

The default save location for your log sheets could be to a shared network folder or to a local folder on your 

computer.  The procedure for recovery is dependent on where the save folder is located. 

Network Save Failure 

If the save location is set to a network folder then log sheets are automatically saved to a temporary folder on 

your computer.  At regular intervals the temporary log sheet is copied to the specified save location. 

If the shared folder becomes unavailable, the log sheet continues to be saved to the temporary folder on your 

computer and you can continue to work uninterrupted.  If the shared folder becomes available, before you exit 

the program, the temporary log sheet is copied to the save location – overwriting the obsolete version.  All of this 

activity occurs in the background without interruption to your normal procedures. 

If the shared network folder is not available when you close the program then a message box is displayed with 

the following information: 

• One or more log sheets have not been saved to the specified save location 

• The temporary files will remain 

• The next time FTR Log Notes is started the temporary log sheets will be saved to the specified save location. 

On closing the message box the temporary files are left intact.  The next time FTR Log Notes is started the 

temporary files are immediately saved to the specified save location. 

Note:  You may be prompted with additional messages if the temporary files are older than log sheets of the 

same name in the save location.  Follow the prompts as required. 

Local Save Failure 

If your specified save location is local to your computer (such as a hard disk drive) and FTR Log Notes is unable 

to save, a message is displayed prompting you to save a copy of the log sheet to another location.  Once you 

have saved a copy then close the active log sheet, open the saved copy and continue. 

REMEMBER TO SAVE THE COPY BACK TO THE ORIGINAL SAVE LOCATION WHEN THE PROBLEM IS RESOLVED. 

Closing Log Sheets 

You can close the active log sheet or any other log sheet. 

To close the active log sheet: 

1. Do one of the following: 

a. Click the Menu button , point to File and click Close or 

b. Right-click the tab and click Close from the shortcut menu or  

c. Click the Close button  to the right of the log sheet tabs 

2. Observe that the previously accessed log sheet becomes the active log sheet. 

To close an inactive log sheet: 

1. Right-click the tab and click Close from the shortcut menu  

2. Observe that the currently active log sheet remains active. 
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Printing 

You can print Log Sheets, Quick Notes or the Word List. 

Printing Log Sheets 

You can print a log sheet or selection of notes from the active log sheet.  Prior to printing you can adjust the way 

the printed page appears by changing the page setup.  You can also preview the print job on screen before 

printing. 

If you wish to print multiple log sheets see Open, Copy, Print or Delete Multiple Log Sheets earlier in this guide. 

To print the active log sheet: 

1. To print a selection from the active log sheet, select one or more rows otherwise skip this step. 

2. Click the Menu button , point to File and click Print or click the Print button . 

3. From the Print dialog box, do one or more of the following: 

a. Select the Heading Page check box to print the contents of the Description, Date and Location fields. 

b. Select the Log Notes option to print notes and then select All or Selection. 

Note:  The Selection option is only available if you previously selected a range of notes. 

 

4. Select a printer, number of copies and collation option, as required and click OK. 
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Page Setup 

When printing notes it may be necessary to change the page setup.  Page setup controls the margins, headers 

and footers. 

To change page setup: 

1. Click the Menu button , point to File and click Page Setup. 

2. In the General tab, select margins and heading page options. 

 

Set margins, as required. 

Heading page options control what is printed when you choose to print heading pages in any print job.  If 

you only print log notes, these options do not apply. 

Select Do not print header on the first page to prevent any header information being printed on the first 

heading page. 

Select Do not print footer on the first page to prevent any footer information being printed on the first 

heading page. 

Select Print separate heading page if you want to print your heading information separate from the log 

notes. 
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3. From the Header or Footer tabs, directly key in your own text or use the predefined Include buttons.  To 

generate a new line (to a maximum of 10) press SHIFT+ENTER.  Use the scroll bars to reveal any hidden text.  

 

Header  and footer information can be aligned left, centre or right.  Click the alignment box you wish to use 

and insert the required information using the Include buttons or by typing your own text. 

Include buttons 

Click  to include the first line of the description field - inserts <DESCRIPTION> 

Click  to include the location name - inserts <LOCATION> 

Click  to include the recording date - <DATE> 

Click  to include the page number - <PAGE> 

Click  to include the total number of pages - <TOTALPAGES> 

Tip:  Pages and total pages are typically entered as Page <PAGE> of <TOTALPAGES> 

4. Click OK to save the settings. 
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Print Previewing 

Before printing you can preview the output on screen to confirm that the page setup is correct. 

To print preview: 

1. Click the Menu button , point to Tools and click Print Preview or click the Print Preview button  

2. From the preview window do one or more of the following: 

a. View other pages by clicking the Prev Page and Next Page buttons as required. 

 
 

 

b. Click Print to print the active log sheet and close all print dialog boxes. 

c. Click Close to exit the Print Preview window. 
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Printing Quick Notes and the Word List 

If you have limited screen space and you do not want to keep the quick notes window open, you can print your 

quick notes and display them in a prominent position near your computer. 

You may also need to print the Word List that is associated with your log sheet. 

Printing Quick Notes 

Printing quick notes is a two-step process that requires you to copy the quick notes to the clipboard and then use 

your text editor or word processor of choice to paste, and print the document. 

To print quick notes: 

1. Click the Menu button , point to Tools and click Quick Notes or click the Quick Notes button . 

2. From the Quick Notes window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the 

clipboard. 

4. When the document is open, make any changes you require and then print the file. 

Printing the Word List 

Printing the word list is a two-step process that requires you to copy the list to the clipboard and then use your 

text editor or word processor of choice to paste, and print the document. 

To print quick notes: 

1. Click the Menu button , point to Tools and click Word List or click the Word List button . 

2. From the Word List window, click Copy. 

3. Using your own text editor or word processor, create a new document and paste the contents of the 

clipboard. 

4. When the document is open, make any changes you require and then print. 
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Keyboard Shortcuts 

Keyboard shortcuts are available in the following categories: 

• General Shortcuts 

• Editing Shortcuts 

• Navigation Shortcuts 

• Selection Shortcuts 

General Keyboard Shortcuts 

Use these shortcuts for the main functions of FTR Log Notes. 

To Press 

Show menu ALT or F10 

Create a new log sheet ALT + F12  (edit mode only) 

Find Text 
Find Next* 

CTRL + F3 
ALT + F3 

Link  F9 

Open a log sheet  F3 

Open shortcut menu  SHIFT + F10 

Open program Options ALT + ENTER 

Print log sheet CTRL + SHIFT + F12 

Quit program\close log 
sheet 

ALT + F4 

Save Copy As F12 

Toggle Edit/Read-only mode SHIFT + F12 

 



 

Page 63 

FTR Log Notes™ 

© FTR Pty Ltd, 2020.  All rights reserved. 

For more information visit www.fortherecord.com 

 

Editing Keyboard Shortcuts 
Use these shortcuts to enter notes and to edit existing notes.  

Note:  Listed shortcuts apply to edit mode only unless otherwise noted.  

To  Press 

Create a new empty log note CTRL + ENTER 

Enter a new line SHIFT + ENTER 

Bold selection  CTRL + B 

Italicize selection  CTRL + I 

Underline selection CTRL + U 

Copy selection in Edit mode or 
Copy selection in read-only mode if Accessibility 
is enabled or 
Copy current field in read-only mode if 
accessibility is disabled 

CTRL + C 

Cut selection  CTRL + X 

Paste  CTRL + V 

Delete character to the right DELETE 

Delete character to the left BACKSPACE 

Add selection to quick notes SHIFT + F3 

Add selection to word list SHIFT + F4 

Undo CTRL + Z 

Redo CTRL + Y 

Selection Keyboard Shortcuts 
Most of the following selection shortcuts apply to a log sheet in edit mode.  Those that also apply to read-only 

mode are marked. 

To  Press 

Select field contents F2 

Select character to left SHIFT + Left 

Select character to right  SHIFT + Right 

Select word to left CTRL + SHIFT + Left 

Select word to right  CTRL + SHIFT + Right 

Select next line.  SHIFT + Down 

Select previous line. SHIFT + Up 

Select to end of line  SHIFT + END 

Select to beginning of line  SHIFT + HOME 

*Select current log note or add current log note to selection  CTRL + SPACEBAR 

*Select all notes between the current log note and the last selected 
log note  

CTRL + SHIFT + SPACEBAR 

 

*Also available in read-only mode. 
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Navigation Keyboard Shortcuts 

Use these shortcuts to move around the log sheet. 

 

Press Edit mode or read-only mode with Accessibility enabled  Read-only mode with Accessibility disabled 

Right Move to next character  Move to next field 

Left Move to previous character Move to previous field 

Up Move up a line in a log note field 
Move and/or scroll up a line in the description or location field  

Move up a field 

Down Move down a line in a log note field Move and/or scroll down a line in the description 
or location field  
Move down a field 

CTRL + Right Move to beginning of next word  No action 

CTRL + Left Move to beginning of previous word No action 

PAGE UP Scroll up a page  Scroll up a page  

PAGE DOWN  Scroll down a page  Scroll down a page  

TAB  Move to next field  Move to next field  

SHIFT + TAB Move to previous field Move to previous field 

   

HOME Move to beginning of the line No action 

CTRL + HOME Move to Description field  Move to Description field  

ALT + HOME Move to first Speaker Field  Move to first Speaker Field  

END Move to end of line No action 

CTRL + END  Move to last Speaker field Move to last Speaker field 

ENTER Move to last Speaker field No action 

 

Note:  With Accessibility enabled, read-only navigation shortcuts behave as edit mode shortcuts. 
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